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1. INTRODUCTION

This document identifies and describes NSIPS production problems and their impact in the field. These problems have an adverse affect on the accomplishment of an NSIPS capability. Unless indicated otherwise in the USER ACTION COLUMN, users are to call the Customer Support Center (CSC) when they encounter these problems and require CSC’s intervention. Items with an “*” at the beginning and shaded in turquoise are new entries.

The problems listed in this document reflect the state of the NSIPS system as of 27 August 2002.  This document will be added to the NSIPS Web Site at URL: http://www.peoit-portal.navy.mil/peoit/communities/community.asp?UserID=2&CommunityID=218
2. KNOWN PRODUCTION PROBLEMS

This section contains a list of problems identified with the NSIPS program that have not been corrected with NSIPS Release 0.2.18.4. These problems will be corrected in a future release.  Until the software has been updated, users are advised to call the CSC, unless instructed to do so otherwise in the USER ACTION column. Affected TACs have been identified for each problem, where applicable. Further questions should be addressed to the NSIPS Customer Support Center (CSC).

2.1 NSIPS Operator Panel Processor Problems

This table identifies problems associated with Operator Panel Processing in NSIPS. 

Description of Problem
TAC
Impact
User Action

Activity Loss -- (Go => Losses => Activity Loss => Use => Activity Loss – Create)
The UIC Report To field in the Activity Loss panel group is pre-filled with the UIC that the member is being lost from, therefore the NSIPS record of the member is not being forwarded to the UIC Report To duty station.  (TT #280381)

The UIC Report To field in the Activity Loss panel group is pre-filled with the UIC that the member is being lost from, therefore the NSIPS record of the member is not being forwarded to the UIC Report To duty station.
User must validate against orders and ensure that the UIC Report To field has the UIC of the command where the member is reporting to as stated in the orders. If the UIC Report To duty station is not the future command, user will need to type in the correct UIC where the member is reporting to.  Correction to the problem will be in a future release of NSIPS.

*Availability -- (Go => Availabilities => Use => Change/Delete)
The Availability Function Code is not updated when orders are received.  (TT #271840)   

The Availability Function Code is not updated when orders are received.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the Availability Function Code in the record. Correction to the problem will be NSIPS Release 0.2.19.0.

Availability -- (Go => Availabilities => Use => Change/Delete)

When an operator submits a deletion to an existing Avail, the user gets the following error message from Corporate: "007 Invalid Avail Class". The Avail Classification Code is not included in the message layout and should have been pulled from the Availability Table's Availability Classification Code Field.  (TT #282996)
AVL(001)
 The Availability Classification Code is not included in the message layout when a user submits a deletion to an existing Avail. User gets error message from Corporate: "007 Invalid Avail Class".
User is to contact the member’s Rating Detailer to request cancellation of existing Avail. Correction to the problem will be in NSIPS Release 0.2.19.0.

Cancel Strength Loss -- (Go => Losses =>Correct/Cancel Losses =>Use =>Cancel Loss – Create)
All Cancel Strength Loss (198) transactions errors out at NES with an error code of 2N (TRANS DATE OF OCCUR < EMR LOSS DATE). NSIPS uses the Loss Date as the date Strength Loss is cancelled vice the System Date. 
198
The 198 transaction fail at NES with a 2N error code.
Update the 198 transactions at NES and re-send the failed transactions. Correction to the problem will be in a future release of NSIPS.

Extensions -- (Go => Contract Administration => Extensions =>Use =>Extensions-Create => Extensions)

When user makes a Branch Class 32 Active Duty Reserve (ADR) Expiration of Active Obligated Service(EAOS) extension operative, the application updates both the Contract End Date and Expiration of Active Service fields.  This blanks out the Expiration of Reserve Enlistment (EREN) on the Extensions Inquire Panel, and erroneously updates the hard and soft EAOS/EREN.  Also, the user is able to make ADR extension operative before making the reserve extension operative.  
387/389
Hard and soft dates for EREN/EAOS are erroneously updated.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the EAOS and the Contract End Date of the record. Correction to the problem will be in a future release of NSIPS.

Inactive Duty Training (IDT) -- (Go => Inactive Duty Training => IDT Unit => Use => Schedule => Schedule/Reschedule)

User scheduled drills for 6/13/02 and successfully cancelled both periods 1 & 2.  User then attempted to re-schedule drills for that same day to Type 6 (Drill Pay Add - Readiness Manning Period) and received the following error: "Type 6 cannot be selected if there exists another drill on the same day".

User is unable to replace cancelled IDT drills with Type 6 IDT for the same date.
User is to call  the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will take appropriate action . Correction to the problem will be in NSIPS Release 0.2.19.0.

Leave -- (Go => Leave Administration => Leave => Use => Leave - Create)  

The Leave Panel Group does not read the current member's record. This creates a job row that does not contain a Department ID thus preventing the user from accessing the record. In turn, user is unable to process Strength Loss. 

A record is created in the Leave Panel Group that does not contain a Department ID, therefore the record can not be accessed by the user.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the record. User then submits transaction.  Correction to the problem will be in a future release of NSIPS.

Personal Data  -- (Go => Personnel Maintenance => Personal Data => Use => Personal Data - Create => Test Scores)
Test Scores (B29(S)) transaction is created for members attached to UIC other than 30646.  (TT #277388)
B29(S)
B29(S) transaction is created for members attached to UIC other than 30646.
User from UICs not in 30646, should ignore the B29(S) reject transactions in their Feedback report.  Correction to the problem will be in a future release of NSIPS.

*Personal Data -- (Go => Personnel Maintenance => Personal Data => Use => Personal Data - Pending)

When a clerk saves a personal data transaction but receives a workflow routing error, the transaction cannot be retrieved again, by the clerk or the selected supervisor. The user receives the ambiguous error message: "There is a pending transaction on this member in an UNKNOWN process (27200,224)." The Clerk should be able to retrieve the pending transaction.  (TT #280301)  

The Clerk or the Supervisor cannot retrieve the pending personal data transaction where a a workflow routing error has occurred.
User is to call the CSC to log a Trouble Ticket (TT). CSC will forward TT to Tier 2 who will reset the pending transaction  from the worklist to allow the clerk to retrieve and work the pending transaction.  Correction to the problem will be in NSIPS Release 0.2.19.0.  

*Personnel Maintenance -- (Go => Personnel Maintenance => Miscellaneous => Use => Local Data => Local Data)

Applies to Reserves Only. A Reserve Clerk attempted to save a change in Personnel Maintenance - Local Data - SELRES panel for a member recently returned from a period of ADSW. The clerk was unable to save the transaction because of  Business Rule 507671which reads "Last Active Duty Date must be less than UIC Report Date ." As coded, the Job Table's Report Date on the top of stack  employee record #1 row must be greater than the Reserve Table's Date Released from Active Duty, which will not be the case for members returning from ADSW or Mobilization unless they transfer.

 (TT #292501) 

The clerk is unable to save a change in Personnel Maintenance Local Data for a reserve member who has recently returned from a period of ADSW.   
User is to call the CSC to log a Trouble Ticket (TT). CSC will forward TT to Tier 2 who will perform the necessary corrections to allow the user to enter transaction. Correction to the problem will be in a future release of NSIPS.  

Sailing Admin -- (Go => Diary => Sailing Admin => Use => Sailing Admin - Create => Embark/Debark Passengers)

When a member reports embarkation of a civilian passenger TAD, a CTAD (Change Number of days Civilian Is Embarked or assigned for TAD or TDY) TAC is erroneously generated. 


CTAD
CTAD TAC is generated erroneously.
Correction to the problem will be in a future release of NSIPS.

Strength Gain (Officer)  -- (Go => Gains =>Strength Gain =>Use => Strength Gain - Create)

Officer Prospective Gain records are pre-staged with Action = TPM (Transaction Process Monitor) and Action Reason = DA (Data Alignment) in the Job Table.  The personnel data strength gain process does not work correctly with these values.  
F8
Updates to the audit/base tables do not occur and related messages are sent with invalid data causing rejects.
User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

Strength Loss  -- (Go => Losses => Strength Loss => Use => Strength Loss - Create)

User cannot separate member who is retained in service using a loss date after the hard EAOS. User receives error indicating that EAOS has expired.  (TT #262518) 



Unable to separate member who is retained in service using a loss date after the hard EAOS.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update EAOS to date member is discharged. User then does the Strength Loss. Correction to the problem will be in a future release of NSIPS.

*Unprojected Gain -- (Go => Gains => Unprojected Gain => Use => Unprojected Gain - Create)

When generating an Unprojected Gain, the GI Bill Eligibility Status Code and the GI Bill Recoupment Status Code are inserted into the GI Bill table. RHS messages G01, G02, G04, G05, G07, G08, G09, G20, G21, S12 contain the values "NGIBE W \NGIBR 6" where the W is apparently converted from the blank sent in the clod and the 6 is the correct value from the base table. Each gain type was checked and the results were the same for Unprojected Gain.  


G01, G02, G04, G05, G07, G08, G09, G20, G21, S12
The GI Bill Eligibility Status Code is reflected as blank in the message generated through Unprojected Strength Gain to CAI.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will reset the values for the corresponding records. Correction to the problem will be in NSIPS Release 0.2.19.0.

2.2 Corporate Asset Interface Related Problems

Corporate Asset Interface (CAI) Related Problems are actions related to unique conversion of individual data fields from NSIPS to Corporate Asset format or vice versa. 
Description of Problem
TAC
Impact
User Action

* CAI ACorpReceiver
A workitem coming up from the field could contain more than one message that needs to go out for a specific corporate asset.  When one of the messages is bad,  CAI rejects the entire workitem instead of  a specific message in the workitem. An example is transaction ID 178771 from RTC Great Lakes. Alocal337 contains 4 messages FK04(001), FK04(002), FK04(003) and FJ04. The FK04(002) and FK04(003) have bad values in them so CAI rejected the entire workitem vice rejecting just  the FK004(002) and the FK04(003).  As a result the local server will not receive any of the feedback on any of the other valid transactions discarded by CAI.

(TT #282127)  

Corporate Asset Interface rejects the entire Workitem when only part of the messages in the Workitem is bad.   
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will perform corrections on the records affected and ask the user to resubmit transaction. Correction to the problem will be in NSIPS Release 0.2.19.0.

2.3 System Administration Problems

This table identifies problems associated with NSIPS System Administration.
Description of Problem
TAC
Impact
User Action

System Administration

Several System passwords are reset to a default  value when a new release is applied to the NSIPS local server. The passwords should not be reset.

Several system passwords are reset to a default value.
The NSIPS System Administrator  needs to change the passwords for  these accounts after loading a new NSIPS release. Correction to the problem will be in a future release of NSIPS.

APPENDIX A–ACRONYMS AND ABBREVIATIONS

ACRONYMS AND ABBREVIATIONS
Abbreviations are in Italics

ADSW
Active Duty for Special Work

CAI
Corporate Asset Interface

EMR
Enlisted Master Record

EREN
Expiration of reserve Enlistment

FTS
Full Time Support

MOB
Mobilization

NEC
Navy Enlisted Classification

NRA
Naval Reserve Activity

NSIPS
Navy Standard Integrated Personnel System

OE
Officer Enlisted

OPINS
Officer Personnel Information System

PS
PeopleSoft

RBSC
Reserve Billet Sequence Code

RHS
Reserve Headquarters System

RTC
Recruit Training Command

SELRES
Selective Reserve

TPM
Transaction Process Monitor

TT
Trouble Ticket
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